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Introduction

Overview

The Comtrol RocketPort/RocketModem Software Installation and 
Configuration Guide covers the following Comtrol software products:
• RocketPort/RocketModem Windows NT Driver (6540)
• RocketPort/RocketModem Windows 95/98 Driver (6533)
• RocketPort/RocketModem Novell NetWare Driver (6535)
• RocketPort/RocketModem SCO OpenServer Driver (6543)
• RocketModem AT Command Set
Please note that these software drivers support a broad range of 
Comtrol hardware products, and that both this guide and the driver 
you install may include features not applicable to your installation.
Each Comtrol adapter, board, or interface comes packaged with a 
Hardware Reference Card, which covers hardware-specific installation 
instructions and performance characteristics. For more information 
about your Comtrol product, see the Hardware Reference Card.

Operating System Requirements
Overview 7

The drivers discussed in this document work with the following 
operating systems:

• Microsoft Windows® NT (3.51, 4.0, or higher)
Note: NT 4.0 or higher is required to support Multilink PPP.

RAS or RRAS is required to support Remote Access Service.
Under NT 4.0, Service Pack 3 is required to support RAS.

• Citrix® WinFrame® (1.7 or later)

• Microsoft Windows® 95 and Windows® 98

• Novell® NetWare® 3.12, 3.2, or 4.1x (with MPR 3.1A or higher and/
or NetWare Connect 2.0.30 or higher)

• Novell IntranetWare I (with NIAS and Support Pack v1.0)

• SCO® OpenServer™ (5.0.x)
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Technical Support

Comtrol has a staff of support technicians available to help you. U.S. 
and U.K. telephone support is available during business hours, 
Monday through Friday (holidays excluded), at the phone number(s) 
listed on the previous page. Before you call Comtrol technical support, 
please have the following information available.

Table 1. Support Call Information

Item Information

Product name

Country where used

Serial number*

Part number**

I/O address***

Interrupt (IRQ)***

Operating system type and 
release

OS service pack number

Driver version number

Computer make, model, 
and speed
8 Technical Support

* Serial numbers can be found on a printed tag on the RocketPort/
RocketModem circuit board.

** Part numbers can be found on both the box and on a tag on the 
circuit board. It is a six-digit number similar to this: 96850-4.

*** The I/O address is set in two places: in the DIP switch block on 
the circuit board, and in the driver software. The IRQ, if used, is 
set in the driver software only.

Other Comtrol products 
installed and their I/O 
addresses, if applicable

Other serial port adapters 
installed and respective 
COM port numbers
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Comtrol Corporate Headquarters

Internet URL: www.comtrol.com
email: support@comtrol.com
FTP site: ftp.comtrol.com
FAX: (651) 631-8117
Phone: (651) 631-7654

Comtrol Europe

Internet URL: www.comtrol.co.uk
email: support@comtrol.co.uk
FAX: +44 (0) 1 869-323-211
Phone: +44 (0) 1 869-323-220

Software and Document Updates

For information not in this guide, see the README  and/or online Help 
files on the installation media.
Comtrol manuals and other documents are available in electronic form 
on the Comtrol corporate headquarters (U.S.) web site. Driver software 
updates can be downloaded at no charge from the Comtrol U.S. ftp site. 
Always check the web and ftp sites to make sure that you have the 
current driver and documentation.
• Comtrol U.S. web site: http://www.comtrol.com
• Comtrol U.S. ftp site: ftp://ftp.comtrol.com
Software and Document Updates 9

The current released version of the software is stored in the Rocket 
directory. If a newer version has reached the beta testing stage, it can 
be found in the BETA  directory. Beta software is made available on an 
“as-is” basis and users of beta software assume all risks and liabilities 
relating thereto.  
Note: Downloadable driver software files are stored in either zipped 

(filename.zip) or self-extracting zip (filename.exe) format. You 
must extract the zipped files before installing a downloaded file. 
For more information, see the appropriate section for your 
server operating system.

http://www.comtrol.com
mailto:support@comtrol.com
ftp://ftp.comtrol.com
http://www.comtrol.co.uk
mailto:support@comtrol.co.uk
http://www.comtrol.com
ftp://ftp.comtrol.com
ftp://ftp.comtrol.com/rocket
ftp://ftp.comtrol.com/beta
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Table 2. Device Drivers for RocketPort and RocketModem

Operating System (Level)
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BSDI (3.0) † * *

FreeBSD 2.2+ † * *

FreeBSD 3.0 † * *

Linux (V1.2.0 or higher) †† * *

MS-DOS (5.0 and 6.2) Int 14 & FOSSIL 6546 * * * * *

Novell (3.12 through 4.11) 6535 * * * *

OS/2 (2.X and 3.X) not WARP Connect 6522†† * *

QNX 4.X (16- and 32-bit) 6523 * *

SCO OpenServer (5.0.X) 6543 * * * *

SCO UNIX/Open Desktop (3.2v4.2 & 3.2v5) 6500 *

Solaris X86 (2.4, 2.5.1, and 2.6) 6519 *

SVR3.2 UNIX (3.2v3 and 3.2v4) 6502 *

SVR4 UNIX (SVR4.2 and UnixWare 1.X) 6503 *

SVR4 UNIX (UnixWare 2.1.X) 6544 * *

Windows 3.1 and WFWG 3.11 6536 * *
10 Software and Document Updates

Windows 95/98 6533 * * * *

Windows NT (3.51 and 4.0) I386 6540 * * * * *

Windows NT (3.51 and 4.0) DEC ALPHA 6540R * * * * *

† See the README the FTP site or use the search engine on the Web site.
†† ftp://tsx-11.mit.edu/pub/linux/packages/comtrol/comtrol-1.12.tar.gz
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Overview

Use this section to install and configure the RocketPort or 
RocketModem driver for the Windows 95 or Windows 98 operating 
systems. This driver supports the following products:
• RocketModem
• RocketPort
• RocketPort 485
Note: The readme.txt file that is delivered with the driver may contain 

additional information not published in this Guide.
For information regarding the specific capabilities of your RocketPort 
or RocketModem adapter, see the documentation that is packaged with 
each Comtrol hardware product.

Installation Prerequisites

Before you begin installation, note the following:
1. This guide assumes that you have already installed the Windows 

95 or Windows 98 operating system (OS) and that you have an 
Overview 11

understanding of OS operation. This product was developed and 
tested using both Windows 95 and Windows 98. These instructions 
were developed using Windows 95; Windows 98 prompts and 
screens may differ slightly.

2. The installation procedures differ depending on whether you are 
installing a PCI- or ISA-bus RocketPort or RocketModem. If you 
need help determining which type of adapter you have, see the 
Hardware Installation Card that came packaged with the adapter.

3. If this is an initial installation  (installing the adapter and driver for 
the first time), go to Installing the New Driver on page 14 and 
perform the procedures listed there in the order given.

4. If you have already installed earlier Comtrol RocketPort or 
RocketModem software on this system, see Updating or Removing 
an Existing Driver, below.
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Updating, Disabling, or Removing the Driver

Updating from an earlier RocketPort Windows 95 Driver

If you are updating from an earlier version of the RocketPort Windows 
95 driver software, install the hardware first, then reboot the system 
and follow these instructions:
1. Access the System Properties window. (Either double-click on the 

Control Panel System icon or right-click on the My Computer  icon 
and select Properties.)

2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem and click Properties.
5. Select the Driver  tab.
6. Click the Update Driver button.
7. Follow the instructions that appear on-screen.

Upgrading from an earlier RocketPort Windows 3.1 or DOS Driver

If you are upgrading from the RocketPort Windows 3.1 or Windows for 
Workgroups driver, you must remove the old software and activate the 
default drivers (comm.drv and vcd.386) before installing the Windows 
95/98 driver. If you need help doing so, contact Comtrol technical 
support.
Note: This driver can co-exist with the RocketPort INT14/FOSSIL 

driver. For more information, see the readme file on the 
12 Updating, Disabling, or Removing the Driver

distribution media.

Disabling the Windows 95/98 Device Driver

To temporarily disable the Windows 95/98 driver, follow these steps: 
1. Access the System Properties window.
2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem and click Properties.
5. Select the General tab.
6. Check the Disable in this hardware profile box.
7. Click OK .
8. Restart the computer so that your changes take effect.
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Removing the Windows 95/98 Device Driver

There are two parts to removing a RocketPort or RocketModem: 
removing the adapter, and removing the driver.
1. Access the System Properties window.
2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem to be removed and click the 

Remove button.
5. Click OK , then Close.
6. From the Control Panel program group, select Add/Remove 

Programs.
7. Select Comtrol RocketPort/RocketModem and click Add/Remove.
8. Click OK .
9. Shut down the computer, switch off the power, and physically 

remove the RocketPort or RocketModem.
Note: Removing the device driver software does not remove the 

Comtrol program group. To remove the program group from the 
Start button menu, see the instructions for “Customizing the 
Start Menu” in the Windows help system.

Removing PCI-Bus Adapters

PCI-bus I/O addresses are slot-specific. If you want to move a PCI-bus 
adapter from one slot to another, you must use Device Manager to 
remove the board first, then shut down the system, remove the 
adapter, and reinstall it in the new slot.
Updating, Disabling, or Removing the Driver 13

If you move or remove a PCI-bus adapter without first removing it in 
Device Manager, the system “thinks” the original board is still 
installed and you must edit the registry to correct this.
Likewise, if you remove the driver without also removing the adapter, 
the system will recognize the “unknown” PCI device and automatically 
start the Add New Hardware wizard each time the computer is 
rebooted.
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Installing the New Driver

Follow the procedures below to install the device driver. 
Note: The installation process varies depending on whether you are 

installing a PCI- or ISA-bus adapter.

Extracting the Installation Files

This driver may be shipped as a self-extracting zipped file. Before you 
can install the driver, you must:
1. Locate the 6533.exe file on the distribution media, or download it 

from the Comtrol ftp or web site.
2. In Windows Explorer, double-click on 6533.exe. The self-extractor 

utility is started.
The utility displays the default target drive and directory where 
the extracted files will be placed. (For example, c:\windows\temp.)

3. Optionally, select a different target drive and/or directory.
4. Click the Unzip button.

The self-extractor utility places the extracted driver files in that 
directory. It also creates a subdirectory labeled \RS485, which 
contains files specific to the RocketPort 485 adapter.
When the process is finished, a reminder message is displayed. You 
may now close the self-extractor utility.

5. If you are installing an ISA-bus adapter, go to page 17.

Software Installation: PCI-Bus
14 Installing the New Driver

Follow these steps to install the Windows 95/98 device driver for use 
with a PCI-bus RocketPort or RocketModem:
1. If you are updating from an earlier version of the driver, install the 

hardware, then use the driver update process described on page 12.
If you are upgrading from the Windows 3.1 or Windows for 
Workgroups driver, you must remove the old software before 
proceeding. If you need help doing so, contact Comtrol technical 
support.

2. Shut down the computer and switch off the system unit power.
3. Install the PCI-bus adapter, following the instructions in the 

Hardware Installation Card.
4. Switch on the system unit and use the bootable Diagnostics to 

verify that the adapter is installed and operating correctly.



Windows 95/98

5. After the adapter passes diagnostics, remove the diagnostics 
diskette and reboot the computer into Windows. 
The system should recognize that a new PCI-bus device has been 
installed and start the Add New Hardware Wizard.

6. If you used the self-extraction process to create an installation 
diskette, insert the device driver diskette when prompted. 
Otherwise, use the Browse option to find the hard drive directory 
to which the driver files were extracted.

7. Click Finish. 
Note: You may be required to re-enter the source directory. Do so 

until it longer requests the source directory.
8. After the install wizard has finished installing the driver software, 

right-click  on the My Computer icon and select Properties.
9. Select the Device Manager tab.
10. Select and open the Multi-function adapters  option:
Installing the New Driver 15
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11. Select the RocketPort/RocketModem device and click the Properties 
button.

12. Select the Board Options tab.
13. Use the Port Select window to select the RocketPort/RocketModem 

port to configure, and the New Name droplist to assign a COM port 
number to the port.
16 Installing the New Driver



Windows 95/98

If the All  box is checked, all ports after the one you select are 
automatically numbered in sequence: 

You can also use the New Description field to rename individual 
ports: for example, you can describe COM5 as RocketPort 1.

14. If desired, click the Advanced button to access the Advanced Board 
Options window. 
For example, the Advanced Board Options are used to configure 
the driver for rates above 230.4K bps. For more information, see 
Advanced Board Options, beginning on page 22.

15. When you are done, click OK  to exit the Board Options window.
16. Click OK  to exit the System Properties window.
17. Reboot the system so that your changes take effect.
18. If you have installed a RocketModem, go to page 27.

To configure all other modems, go to page 29.
Installing the New Driver 17

To configure serial printers, go to page 31.

Software Installation: ISA-Bus

Follow these steps to install the Windows 95/98 device driver for use 
with an ISA-bus RocketPort or RocketModem:
1. If you are updating from an earlier version of the Windows 95/98 

driver, install the hardware, use the driver update process 
described on page 12, then update the configuration as needed.
If you are upgrading from the Windows 3.1 or Windows for 
Workgroups driver, remove the old software before proceeding. If 
you need help doing so, contact Comtrol technical support.

2. Click the Start button, select Settings, then select Control Panel.
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3. Double-click the Add New Hardware icon. The Add New Hardware 
Wizard starts.

4. Click Next. You are asked if you want Windows to search for new 
hardware

5. Click No, then click Next. 
18 Installing the New Driver
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You are asked to select the type of hardware to install:

6. Select Multi-function adapters  and click Next. A list of board 
manufacturers and models displays. 

7. Click the Have Disk button. Then enter the drive and directory 
where you stored the extracted installation files and click OK .
The list of products supported by this driver displays:
Installing the New Driver 19
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8. Select the Comtrol product you are installing and click Next. The 
Add New Hardware Wizard selects an I/O address and IRQ 
setting. Make note of these values, as you may need to change them.

9. Click Next. The system copies the driver files and rebuilds the 
driver database.

10. Click Finish. The following message displays: 
20 Installing the New Driver

11. If the I/O address and interrupt selected by the system in Step 8 
match those you plan to use when installing the hardware, click 
Yes to shut down your computer and skip to Step 12.
If the I/O address or interrupt selected in Step 8 do not match those 
you plan to use, click No, then follow these additional steps:
a. Access the System Properties window. (Either double-click on 

the Control Panel System icon, or right-click on the My 
Computer icon and select Properties.)

b. Select the Device Manager tab.
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c. Double-click on Multi-function adapters .
d. Select the RocketPort or RocketModem and click Properties.
e. Select the Resources tab.
f. Select Input/Output Range and click the Change Setting button.
g. Set the Value to the hardware I/O address you plan to use.
h. Optionally, select Interrupt Request and click the Change Setting 

button, then set the Value to the IRQ you plan to use.
i. Make sure the Use automatic settings checkbox is blank.
j. Click OK  to return to the Resources tab.
k. Click OK  to close the window. A warning message displays.
l. Click Yes to continue. Another message displays advising you to 

shut down and restart your computer.
m. Click Yes. Then shut down your computer.

12. When it is safe to do so, switch off the computer’s power and 
install the RocketPort or RocketModem, following the instructions 
in the Hardware Installation Card.
Note: Pay special attention to the I/O Address DIP switch setting. 

If the address you select on the hardware does not match 
the address selected in the software, you will need to repeat 
Step 11 later and shut down and reboot again.

13. Switch on the system unit, and use the bootable Diagnostics 
supplied with the hardware to verify that the adapter is installed 
and operating correctly.

14. After the adapter passes diagnostics, remove the diagnostics 
diskette and reboot the computer under Windows. The system 
Installing the New Driver 21

should recognize that new hardware has been installed and 
automatically find and install the software for it. Be patient; this 
may take some time.
When the process is complete, the system creates and displays the 
Comtrol RocketPort/RocketModem program group:



Windows 95/98

15. Your system is now ready for use. No reboot is necessary.
16. If desired, continue with the Advanced Configuration options, below.

To configure external modems, go to page 29.
To configure serial printers, go to page 31.

Advanced Configuration

After initial installation, use the following procedures to change 
RocketPort/RocketModem configuration settings.

COM Port Numbering

When installing a PCI-bus RocketPort, the COM port numbers are 
usually set in Step 13 of the PCI installation procedure. When 
installing an ISA-bus RocketPort or RocketModem, the first Comtrol 
port defaults to COM5 and the other ports follow in sequence.
To change the COM port number assignment, follow these steps:
1. Access the System Properties window. (Either double-click on the 

Control Panel System icon or right-click on the My Computer  icon 
and select Properties.)

2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem and click Properties.
5. Select the Board Options tab. 
22 Advanced Configuration
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Your current COM port assignment displays:

6. Use the Port Select window to select the RocketPort/RocketModem 
port you want to work with.
Advanced Configuration 23

7. Use the New Name droplist to select the COM port number you 
want to associate with the selected port.
Note: Do not use an existing COM port number. If you do, the 

existing port will be disabled.
If the All  box is checked, then all subsequent ports are numbered 
in sequence. If the All  box is not checked, you can set the COM 
number for each port individually.

8. If desired, use the New Description field to give each port a more 
descriptive or meaningful name.

9. When you are done, click OK  to return to the System Properties 
window.

10. Your changes take effect immediately. No restart is required.
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Remapping Baud Rates

This option lets you remap the 300, 600, 1200, and 2400 baud rates to 
more useful values. A common use of this option is to enable an 
application to use a higher baud rate than is otherwise available.
Once a value is placed in one of the mapped fields, whenever an 
application selects the mapped rate, the alternate rate is used instead. 
For example, if you map 300 to 115200, then select 300 baud in an 
application, the actual baud rate used is 115,200.
Follow these steps to remap baud rates:
1. Access the System Properties window. (Either double-click on the 

Control Panel System icon or right-click on the My Computer  icon 
and select Properties.)

2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem and click Properties.
5. Select the Board Options tab.
6. Click the Advanced button. This window displays:
24 Advanced Configuration

7. In the Baud Rate Mapping section of this window, select the rate 
you want to remap.

8. Use the droplist to select a new baud rate, or type in a value.
Note: See the Hardware Installation Card to determine which 

baud rates are supported by your RocketPort or 
RocketModem.
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9. Repeat Steps 7 and 8 as required.
10. If mapping to a rate above 230.4K bps, set the scan rate as 

described below.
11. Click Done to save your changes and return to the Board Options 

window.
12. Click OK  to return to the System Properties window.
13. Your changes take effect immediately. No restart is required.

Scan Rate: Using Baud Rates Above 230.4K bps

The Scan Rate option on the Advanced Board Options window is used if 
you are driving ports at rates above 230.4K bps. For example, to drive 
a RocketPort Octacable at 460.8K bps, set the Scan Rate to 5 ms.
In order to use a Scan Rate faster than 10 ms, the Use IRQ box must 
also be checked. As this is the default state of the driver, this is not 
normally an issue. However, see the following topic.

Installation Without a Dedicated IRQ

You can configure this driver to run without an IRQ selection. In this 
state the controller runs off the system timer.
To run without an IRQ, uncheck the Use IRQ box on this screen. (This 
does not free up the IRQ, but simply informs the driver not to use it.)
If you are experiencing IRQ conflicts or need to make more substantial 
changes, see Changing the IRQ on page 26.

Stay Resident

This driver is normally loaded into memory only when needed. If you 
Advanced Configuration 25

check the Stay Resident box on this screen, the driver is forced to stay 
resident in memory, which can be useful for avoiding the loading and 
unloading process.
Note: If the Stay Resident option is checked, you may need to restart 

your system before driver configuration changes take effect.

Fast

The Fast checkbox on the Advanced Board Options window sets output 
queue reporting to be based on the software buffer alone. This option 
is selected by default as it produces faster throughput and better 
efficiency. Some specialized applications may need to know precisely 
(down to the millisecond) when data is actually sent out the port, in 
which case you may need to uncheck this option.
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Changing the IRQ

If you experience IRQ conflicts or need to make more substantial 
changes beyond disabling IRQ use, follow these steps:
1. Access the System Properties window.
2. Select the Device Manager tab.
3. Double-click on Multi-function adapters .
4. Select the RocketPort/RocketModem and click Properties.
5. Select the Resources tab.
26 Advanced Configuration

6. Select Interrupt Request.
7. Click the Change Setting button.
8. Use the Value control to adjust the interrupt. The range of 

available options is determined by the board type. If a PCI-bus 
adapter is installed, you cannot change the interrupt.
If all the Comtrol boards in the computer are ISA-bus, your options 
are None, 3, 4, 5, 9, 10, 11, 12, or 15.
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Pay attention to the Conflict information  window, as it displays the 
names of other devices using the selected interrupt.

9. Make sure the Use automatic settings checkbox is clear (empty).
10. Click OK  to return to the Resources tab.

Optionally, if it is an ISA controller, select Basic Configuration 2 to 
run without an interrupt.
Optionally, if it is a PCI controller, you may be able to use the 
System Setup Utility to allocate IRQ lines between the ISA and 
PCI bus. If the PCI slot does not have an IRQ assigned to it, the 
driver uses the system timer for its service. Use of an IRQ is 
strongly recommended for port speeds of 115,200 and higher.

11. Click OK  to exit the System Properties window.
12. Reboot the system so that your changes take effect.

RocketPort 485

If you have installed one or more RocketPort 485 adapters in your 
computer and have configured the adapters for RS-485 operation (see 
the RocketPort 485 Hardware Installation Card for more information), 
read this subsection.
Note: RS-485 operation is configured by setting jumpers on the 

RocketPort 485. If you have not installed at least one RocketPort 
485 and configured it accordingly, do not use this option.

This driver supports toggle-mode (toggle RTS low during transmission) 
RS-485.
This mode must be invoked in an application by using a custom driver 
RocketPort 485 27

call as demonstrated by the rtty.exe and wcom32.exe programs. Source 
is available for these files in the \RS485 subdirectory that is created 
when you extract the driver files. You can get instructions for RTTY by 
entering rtty  at the DOS prompt. RS-485 toggle can be invoked from a 
menu button in the sample version of WCOM32.

Adding RocketPort Cards

To add more PCI-bus adapters to an installed and working RocketPort 
or RocketModem installation, simply shut down the computer and 
install the new boards. When the computer is switched on again, it 
recognizes the new boards and installs driver software for each port 
automatically.
To add more ISA-bus adapters to an existing installation, follow these 
steps:
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1. Click the Start button, select Settings, then select Control Panel.
2. Double-click the Add New Hardware icon. The Add New Hardware 

Wizard starts.
3. Click Next. You are asked if you want Windows to search for new 

hardware.
4. Click No, then click Next. You are asked to select the type of 

hardware to install.
5. Select Multi-function adapters  and click Next. A list of board 

manufacturers and models is displayed. 
6. Select Comtrol . Then select the model of RocketPort or 

RocketModem you are installing. 
7. Click Next. The install wizard selects an available I/O address and 

IRQ setting.
8. Click Next. 
9. Click Finish. 
10. Click Yes to shut down your computer. Turn off the power.
11. Set the I/O address DIP switches as described in the Hardware 

Installation Card. 
12.  Install the new adapter.
13. Switch the computer back on and use the bootable diagnostic to 

verify that the board is installed and operating correctly.
14. After the board passes diagnostics, remove the diagnostic disk 

from the drive and reboot the system into Windows.
15. Reset the board basic configuration:

a. Access the System Properties window. (Either double-click on 
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the Control Panel System icon, or right-click on the My 
Computer icon and select Properties.)

b. Select the Device Manager tab.
c. Double-click on Multi-function adapters .
d. Select the new RocketPort/RocketModem and click Properties.
e. Select the Resources tab.
f. Set “Setting Based on” to Basic Configuration 1.
g. Click OK  to close the window. A warning message is displayed.
h. Click Yes to continue. Another message is displayed advising 

you to restart your computer.
i. Click Yes.

16. Shut down and restart the computer, so your changes take effect.
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Configuring Modems

RocketPort adapters can support any asynchronous serial modem for 
use by any application that uses Windows 95/98 COM ports.
Note: There is one exception to this rule: the RocketPort 8J is not 

recommended for use with modems, as it lacks the full-range of 
control signals. All other RocketPort models work with modems.

RocketModem boards are essentially RocketPort boards with built-in 
and dedicated modems. The serial ports are not accessible externally.
Follow these steps to install and configure modems. Exceptions for 
RocketModems are called out.
1. If using a RocketPort, connect the modem(s) to the desired port(s). 

Power up the modem(s).
2. Open the Control Panel window.
3. Double-click on the Modems icon. The Install New Modem wizard 

starts:
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4. Check the “Don’t detect my modem” box.
Note: Do not use the auto-detect feature. The Windows modem 

auto-detect function does not recognize ports above COM10, 
and it scans down, beginning with the highest detected 
COM port. This can produce extremely confusing modem-
to-port numbering and naming sequences.
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5. Click Next. A list of modem manufacturers and models displays:

6. RocketPort: select your modem from the lists, or click Have Disk.
RocketModem: select Comtrol  and the appropriate RocketModem 
model.

7. Click Next. The list of available ports displays: 
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8. Select the port to which the modem is attached and click Next. The 
system installs the modem software.
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9. Click Finish. The Modems Properties window displays: 

10. To add more modems, click the Add button and repeat Steps 4 
through 9.

11. Optionally:
a. Click Dialing Properties to configure basic phone service 

information.
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b. Highlight a modem and click Properties to configure port speed, 
data bits, parity, and so on.

c. Click the Diagnostics tab, then select a port and click More Info  
to query and test the modem.

12. When you are done, click Close to exit the Install New Modem 
wizard. Your changes take effect immediately. No reboot is 
required.

Configuring Printers

Follow these steps to connect a serial printer to a RocketPort.
Note: You may need the Windows 95 or Windows 98 CD-ROM in 

order to load drivers and complete printer installation. Make 
sure you have this CD on-hand before beginning the process.
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1. Connect the printer to the desired port. Use a DTE-to-DTE null 
modem cable unless the printer maker specifies otherwise.

2. From the Start button menu, select Settings, then Printers.
3. Double-click on the Add Printer  icon. The Add Printer Wizard 

starts.
4. Click Next.
5. Select Local Printer  and click Next.
6. Select your printer make and model and click Next. 

If your printer is not listed, click Have Disk to use the printer 
manufacturer-supplied driver. Some printer manuals will tell you 
to use another manufacturer’s printer driver.

7. Select one of the available COM ports and click Configure Port.
8. Enter the baud rate, flow control, and other information as 

specified by the printer manufacturer, and click OK .
9. Click Next.
10. Optionally, enter a custom name for this printer, and select 

whether this printer is the Windows default printer. Click Next.
11. Select whether to print a test page and click Finish.

You may be prompted to insert the Windows 95/98 CD-ROM in 
order to load drivers. Do so and follow the on-screen instructions.

12. If the test page prints successfully, you are ready to begin using 
the printer. No reboot is needed.

Changing Printer Port Configuration After Installation

To change port configuration after a printer is installed, open the 
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Printers window, right-click  on the printer in question, then select 
Properties from the menu.
All port configuration options are found on the Details tab.

Troubleshooting

If you are having trouble with a RocketPort or RocketModem adapter, 
try the following:
1. Verify that you are addressing the port correctly. In many 

applications, device names above COM9 require the prefix \\.\ in 
order to be recognized. For example, to reference COM20, use 
\\.\COM20 as the file or port name.

2. Verify that you are using the correct types of cables in the correct 
places and that all cables are connected securely at both ends.
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3. Verify that you have obtained and installed all Microsoft service 
packs for your operating system.

4. Verify that you have the latest Comtrol driver for your adapter 
and operating system. Current versions of all Comtrol software 
can be downloaded at no charge from the Comtrol web or ftp sites.

5. Verify that you are using the correct ports. The 
RocketPort 8J uses the displayed bracket.
The RocketPort 4J uses four RJ45 jacks. The port 
at the “top” edge of the card is Port 1, and the port 
at the “bottom” edge of the card is Port 4.

6. If you are using an ISA-bus adapter, check to 
make sure that the DIP switch on the adapter is 
set an I/O address that matches the I/O address 
selection, and that there are no address or 
interrupt conflicts with other boards.

7. Use the Advanced Board Options to reset the 
Scan Rate and IRQ to the default settings.

8. Make sure the RocketPort is seated firmly in the 
expansion slot, and that the expansion slot screw 
is in place.

9. Remove the driver software and reinstall it, 
using a different I/O address (ISA-bus adapters only).

10. Use the Test Terminal program (page 38) to troubleshoot 
communications on a port-by-port basis.

11. Use the Port Monitor program (page 40) to check for errors, 
modem control, and status signals.

12. Shut down the server, reboot from the Diagnostic diskette, and 

Modem
1
2
3
4
5
6
7
8
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follow the on-screen instructions to test the hardware.
13. If you are unable to resolve the problem, see the Introduction for 

information on contacting Comtrol technical support.

Known Issues

In addition to the general tips listed above, we have identified a 
number of specific issues and conditions that affect RocketPort or 
RocketModem performance.
• All products

The Control Panel Add/Remove Software option can be used to 
remove the driver, version 1.42 or later. Earlier versions of the 
driver cannot be removed through this option. 
If you need help removing an earlier driver from your system, see 
for information on contacting Comtrol technical support.
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• All PCI-bus products
PCI-bus I/O addresses are slot specific. If you want to move a 
RocketPort from one PCI slot to another, you must use the Device 
Manager to remove the board first, then shut down the system, 
remove the adapter, and reinstall it in the new slot.
If you move or remove a PCI-bus adapter without first removing it 
in Device Manager, the system “thinks” the original board is still 
installed and you must edit the registry to correct this.

• RocketPort with 3COM/U.S. Robotics Modems
Symptom: Message displays, “The communication device attached 
to COMxx is not functioning.”
Solution: Most USR modems come from the factory set to “Load 
NVRAM defaults.” Reconfigure the modem to “Load Factory 
Defaults,” as the driver issues settings from the mdm*.inf  file.

Driver Error Messages

The driver may display a blue screen error message if it determines a 
fault condition. The following lists some of the possible errors. 

Table 3. Driver Error Messages

Message Condition Solution

Interrupts Not 
Functioning

The driver tested and 
determined the 
interrupt (IRQ) is not 
functioning properly. 

Change the IRQ or run 
without an IRQ.

IRQ Initialization The driver could not use 
the interrupt specified.

Change the IRQ or run 
without an IRQ.
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Hardware error- 
ctrl:## Addr:##, 
Irq:##

A hardware error was 
encountered while 
initializing the board 
hardware.

Change the I/O setting 
(if ISA, make sure you 
check/change the I/O DIP 
switch.

Number of Ports 
Mismatch

The actual number of 
ports on a board does 
not match the 
configuration.

Delete in Device 
Manager and reinstall 
with correct Comtrol 
adapter selected.

Hardware 
Channel Init

A specific port could not 
be initialized at the 
hardware level.

Run the Diagnostic.
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Programming Information

Microsoft provides technical support for communication calls, which 
the RocketPort or RocketModem series supports. This means most 
applications for the Windows 95/98 operating system (or other 32 bit 
programs) operate on RocketPort or RocketModem ports without 
modification. 
To assist you, Comtrol has created sample code (PROG32.ZIP), which is 
available on the WEB and FTP sites. For further examples, you can 
look at Microsoft Windows 95/98 Software Development Kit (SDK) 
Programming Reference books. 
For help programming COM API, contact Microsoft technical support.

Windows 95/98 Software Support

This driver uses the Microsoft COMM API and supports all 
applications that use the Windows 95/98 COMM driver. This includes 
but is not limited to:
• Hyperterminal
• Briefcase
• Microsoft Mail and FAX
• Microsoft Online/Exchange
• Dial-Up Networking
• PPP/SLIP
• Most Microsoft 16- and 32-bit API-supported applications.

Driver Limitations
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The following are known limitations of the driver and are not 
implemented due to hardware constraints or lack of demand. The 
following are options used in the SetCommState() programming call.
• fTXContinueOnXoff  - Not Implemented. Option to stop Tx Flow 

when RocketPort sends a Xoff.
• fDSRSensitivty - Not Implemented. This option ignores any received 

data while DSR is not active.
• fRTSToggle - Not Implemented. This option turns the RTS on 

during data transmission.
• Parity    - Only NONE/ODD/EVEN supported (No mark or No 

space).
• StopBits - Restricted to 1 or 2 (No 1.5).
• ByteSize - Restricted to 7 or 8 (No 5, 6).
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The Windows 3.1 special RocketPort library calls are not supported in 
Windows 95/98 (this was supplied for Windows 3.1 only as a means of 
opening ports above COM10.)
In Windows 95/98, the current solution is to rewrite the program as a 
32-bit program and then use the special sequence \\.\COM11 in the 
CreateFile() call.

DCB Device Control Block Parameters

• XonLim , XoffLim  - The RocketPort or RocketModem series does not 
handle flow control like traditional PC COM ports. Keep in mind 
the adapters have large hardware input/output buffers, and any 
control strategy based on buffer levels brings the following 
question: should the trip point be in reference to the hardware 
buffer, or the driver software buffer, or both? And if the hardware 
performs the flow control, you cannot consider the software buffer 
in the equation. You also need to balance this with efficiency.
RTS/CTS flow control is handled by the RocketPort or 
RocketModem card on a hardware level. The RTS trip points are 
hardwired to about 7/8 full and empty in relation to the hardware 
input buffer of 1,024 bytes.
DTR/DSR flow control is handled at the software driver level. The 
DTR trip point is hardwired at the level at which the software input 
buffer becomes full (the hardware input buffer of 1,024 bytes still 
remains). The low level is XonLim , and is in relation to the drivers 
software buffer. 

• fOutX  - if set, this cause data transmission to halt upon reception 
of a XOFF char and resume when a XON char is received. The 
XON/XOFF characters are specified by XoffChar  and XonChar 
parameters and may be changed by the application. The trip points 
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are hardwired to 7/8 full and empty in relation to the hardware 
input buffer of 1,024 bytes.

• fInX  - if set, when the receive buffer is near full, an XOFF char will 
be sent out to stop the incoming flow of data. When the receive 
buffer empties, the XON character is sent to resume incoming data. 
The fInX  trip point is hardwired at the level at which the software 
buffer becomes full (same as DTR above).

• fBinary  - Leave this bit set on! ASCII mode (this value at zero)   
enables the EOF char to be detected. After the EOF char has been   
detected, no more data is allowed to be read, and an overflow error 
is displayed if more data is received. While Non-Binary mode is 
supported, it should not be used.
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Bypassing the Normal Windows 32 APIs

An application program cannot talk to the port driver directly, and 
must go through the normal API calls. In the Windows 95/98 
environment it is possible to write a VCOMM client to bypass the 
Win32 API layer, but this is not recommended and is not portable to 
the Windows NT environment.

Real Time Issues

The driver runs in a polled interrupt fashion; the system is 
interrupted every poll period. The poll period default is 10 
milliseconds (100 Hz).
What this means is that all Event processing is restricted to the poll 
period interval. This will only be a problem for some applications that 
require very precise synchronization with other hardware. In some 
cases, this may be worked around by polling the queue counts through 
GetCommError ().

Opening Ports Higher Than COM10

In order to open up COM ports higher than COM10 a special named 
format is used with CreateFile(): \\.\COM10 (when using the C language 
you need to double up the backslashes: \\.\COM10. This works only for 
32-bit programs running under Windows NT or Windows 95/98. In 
Windows 3.1 there is no provision for opening COM ports above 
COM10. Comtrol had developed a custom library to work around this 
problem under Windows 3.1. 16-bit applications running under 
Windows NT or Windows 95/98 also have this restriction.

COMMTIMEOUTS: 
GetCommTimeouts() and SetCommTimeouts() Structure
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These features are implemented in a standard part of the operating 
system and not in the port-driver, although it does rely on callback 
facilities built into the driver. These timeouts should be used to avoid 
getting stuck forever in a read or write operation when using the 
standard (non-overlapped) mode of operation.
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Using Test Terminal (wcom32.exe)

WCOM32 is a terminal program that enables you to open a port, send 
characters and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on a port if any other application is 

using the port. Stop all passive or background fax or telecomm 
programs before using WCOM32. 

To start WCOM32, select Test Terminal from the Comtrol RocketPort 
RocketModem program group. The program window displays: 

Follow these steps:
1. Select Open Port from the Port menu. A list of possible COM port 
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numbers displays.
2. Select the COM port you want to test.

If the COM port does not exist or if it is currently being used by 
another program, a Create File Error message displays.
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If the COM port is available, a terminal window pops up:   

Note the <loop> button in the terminal window. If this option is 
activated, it is green and uppercase ( ), the COM port internal 
loopback feature is activated and the data is returned by the COM 
port hardware. If this option is deactivated, it is gray and lowercase 
( ), the internal loopback is deactivated, and the data is being 
sent out the COM port.

Testing a RocketPort

1. Place a loopback plug on the COM port you are testing. Make sure 
the loop button is off.
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2. From the Port menu, select Send Test Data. The program sends out 
a repeating data stream. To stop this, select Send Test Data again.
If the loopback plug is in place and the port is working correctly, 
the test data should be echoed back to the screen.
If the loopback plug is not in place or the port is not working 
correctly, no data or garbled data is echoed back to the screen.

Note: If no characters appear, try putting the loopback plug on an 
adjacent port. It may be that you have the ports mixed up.

3. If further testing is required, select Loopback Test from the Port 
menu. If the loopback plug is in place and the port is working 
correctly, the system should return the message “Passed.”
If the loopback plug is not in place or the port is not working 
correctly, the system will return the message “Failed.”
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4. If the port has failed in Step 2 or 3, and the RocketPort is equipped 
with an external interface box or fanout cable, click the loop button 
to switch the internal loopback feature on.

5. Repeat Steps 2 and 3. If the port now passes the tests, the fault 
may lie in the interface box or fanout cable. Contact Comtrol 
technical support for more assistance.

Using Port Monitor (rktmon.exe)

The Port Monitor program (rktmon.exe) offers a summary of all 
RocketPort or RocketModem statistics in one easy-to-read spreadsheet 
view. It also enables you to verify operation of all RocketPort or 
RocketModem ports from a single window. 
The Port Monitor display follows the familiar spreadsheet model: each 
COM port is a horizontal row, and each vertical column displays a 
variable or value for the respective COM port. (For definitions of the 
abbreviations used, see the Port Monitor Variable List table.) 
Port Monitor can also produce statistics and reports that can help you 
verify the operation of the COM ports and connected peripherals. 
Some immediate feedback includes:
• The state of the modem control and status signals.
• Open ports.
• Raw byte input and output counts obtained from the driver.
• Port errors.
The available statistics include:
• Instantaneous characters per second (CPS) calculations.
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• Minute, hour, and day CPS averages and peaks.
• Carrier detect (CD) signal runtime and transition count.
Reports can be automatically generated on an hourly and/or daily 
basis, and can cover all ports collectively or a separate report for each 
port. You can also set how often the values are recalculated, fine-tuning 
thoroughness against system efficiency, and automatically run 
external batch files to perform additional processing and analysis.

Starting Port Monitor

To run Port Monitor, select Port Monitor  from the Comtrol RocketPort 
RocketModem program group. 
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The monitor window displays: 

Once the monitor window displays, Port Monitor is active and 
collecting data. If any cumulative data has been saved from previous 
sessions, it is automatically brought in and used.
Port Monitor continues to run and collect data until you terminate it, 
at which point all accumulated data is automatically saved for use in 
the next session.

Changing Screen Appearance

While Port Monitor is running, there are a number of commands and 
controls that change the appearance of the screen.

Table 4. Port Monitor Screen Commands

Desired Change Procedure

Change the monitor window font. Select Font from the Edit menu.

Left-click on the column separator 
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Change width of a single column. (vertical) line and drag it to the 
desired width.

Change column placement.
Left-click in the middle of the 
column you want to move and 
drag it to the desired location.

Remove a column.
Right-click on the column you 
want to remove and select Remove 
from the pop-up menu.

Clear all fields and reset them to 
null values.

Right-click on the upper left cell 
in the table and select Reset from 
the pop-up menu.*

Clear any single field except the 
upper left cell.

Right-click on the field to be 
cleared and select Reset from the 
pop-up menu.*
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* The Reset command does not clear raw data from the calcs.dat file. 
It simply resets the selected display fields to their null values. For 
more information regarding calcs.dat see page 44.

Column Setup

When you select Add or Properties from the column pop-up menu, the 
Column Setup window displays: 

Add a column.

Right-click on the column now 
occupying the desired location 
and select Add from the pop-up 
menu.
You are prompted to name the 
variable you want to display, as 
well as other information. (See 
Column Setup, below.) 
After you click OK , the column is 
inserted in the selected location 
and the existing column is moved 
to the right.

Change other properties of a 
column.

Right-click on the column and 
select Properties from the pop-up 
menu. (See Column Setup, below.)

Table 4. Port Monitor Screen Commands

Desired Change Procedure
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Use the Input  droplist to select the variable displayed in the column.
Use the Type droplist to select the way in which the value displays: 
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either as an integer, as an on/off state, as an integer with a kilo, mega, 
or giga suffix, or as an hh:mm:ss time stamp. This defaults to the 
appropriate type for the selected Input variable.
Use the Name variable to change the column heading name.
Use the Width  variable to specify the column width in characters.
Use Color0 to set the column character color when the value is zero.
Use Color1 to set the column character color when the value is not zero.
When done, click OK  to save your changes and return to Port Monitor.

Report Configuration

To configure reports, select Config from the Edit menu. The Program 
Setup window displays: 
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The Single report options cover all ports and are overwritten each time 
the reports are generated. The Multiple  report options generate a 
separate report for each port, and each report file is appended each 
time the report is generated.
For Hour  reports, use the Single and Multiple droplists to select 
whether you are generating single or multiple reports, or both. For 
each report type, select from the following types of data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name are included.
• All Data: all variables are included.
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• View Data: only variables that appear on-screen are included.
The External Program field is used to enter a command line to run 
another program after the hourly reports have been generated. For 
example, you can use this to run a batch file that performs custom 
report processing. The Test button causes the command line to be 
executed immediately.
For Day reports, the single and multiple droplists behave the same, but 
your choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the 

names are included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor 

window are included.
Likewise, the External Program field is used to enter a command line to 
be executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port 
information is obtained and the calculations performed. There is a 
trade-off between Port Monitor efficiency and response time. If you are 
using Port Monitor to view the port activity on the screen, you may 
want to set the update time to 1 or 2 seconds, so that the screen is 
updated frequently. If you are concerned about the monitor program 
using CPU resources, set this to a higher value, (6 to 20 seconds) in 
order to decrease the time required by the program to perform the 
calculations and update the screen.
If Port Monitor is left active to generate reports, minimizing or 
reducing the display area of the program will help reduce CPU 
requirements of updating the screen.
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Port Monitor Files

Port Monitor creates and uses the following files:
• rktmon.vew

• calcs.dat

The default column layout is saved in rktmon.vew. If you have been 
experimenting with the appearance of the monitor screen, you can use 
the File menu Save option to save your customized layout in another 
.vew file. You can retrieve this file later by using the File menu Open 
option, or you can use the Edit menu View Default option to retrieve 
rktmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour 
in a binary file named calcs.dat. This enables you to halt Port Monitor 
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execution without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily 
reports are saved in this directory, under the following names:
• hall.txt  — hourly single report
• dall.txt  — daily single report
• hcomx.txt  — hourly multiple reports, where x is the port number
• dcomx.txt  — daily multiple reports, where x is the port number
WARNING:  Since multiple reports append new data each time they are 
written, the multiple report files grow in size. It is up to you to delete 
them periodically.
Some safeguards are built into the program to avoid filling up a hard 
disk drive due to growing report files. The monitoring program stops 
writing additional data to the multiple reports if they reach a size of 2 
MB. Also, the program will not write out data files to the disk drive if 
the spare room on the drive is less than 2 MB in size.
To view or edit an hourly or daily report, use the Edit Report option on 
the File menu, or use a system tool such as NOTEPAD.
For more information, see the Port Monitor Help file.

Port Monitor Variables 

The following table lists Port Monitor variables. 
Table 5. Port Monitor Variable List

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.
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Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit 
characters per second.

RxCPSInst Instantaneous average of receive characters 
per second.
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Errors Total hardware receive errors (parity, 
framing, and overruns.)

TxMinCPS Last minute average of transmit characters 
per second.

RxMinCPS Last minute average of receive characters 
per second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data 
from the driver.

RxTotalRaw Total number of receive bytes raw data from 
the driver.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

Table 5. Port Monitor Variable List

Variable Description
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RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.
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TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current 
day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on 
in the last hour.

CDDayRunTime Time in seconds carrier detect has been on 
in the last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on 
this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on 
this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

Table 5. Port Monitor Variable List

Variable Description
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OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from 
the driver.

FramingErrorsRaw Total count of receive framing errors, from 
the driver.

ParityErrorsRaw Total count of receive parity errors, from the 
driver.
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